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Disclaimer 

MYOB has made every attempt to ensure the accuracy, relevance and completeness of this material but excludes (to the 
extent allowed by legislation) any warranties regarding it. Furthermore MYOB, its staff and agents shall not be liable for any 
loss, cost or damage (however incurred including negligence) arising out of errors or omissions in the material, especially if 
such materials contain information sourced from third parties or the ATO. In some cases the materials provided contain case 
studies (applying particular accounting standards or legislation) and anecdotes which may not directly apply to the user's 
circumstances and are used as representative examples only and should not be considered as authoritative advice regarding 
any accounting standard, law or industry opinion. MYOB advises that if the user wishes to rely on the case studies contained 
in the material then it must seek professional advice before doing so. Furthermore reliance on the representative examples in 
the seminar materials is at the user's own risk. 

 

Copyright 

Furthermore the seminar and materials may not be copied, altered, edited, disposed of or distributed without the prior written 
consent of MYOB. 

 

Trademarks 

All trademarks used in this material are owned by MYOB Technology Pty Ltd or the indicated registered owners of the 
trademarks. Users are forbidden from using, copying or transporting the trademarks without express prior written consent. 
AppleShare and Macintosh are registered trademarks of Apple Computer, Inc., registered in the United States and other 
countries. LiveLinks is a trademark of Ceedata Holdings Pty Ltd. Microsoft, MS-DOS, Windows, Windows NT, Windows 
BackOffice and Outlook are either registered trademarks or trademarks of Microsoft Corporation in the United States and 
other countries. Novell and Netware are registered trademarks of Novell, Inc.  

MYOB Technology Pty Ltd ® 

ABN 30 086 760 269 

Level 3 

235 Springvale Road 

Glen Waverley VIC 3150 

MYOB Practice Manager Emailing Debtor Statements Template Guide 2016+ 

Updated: September 2019 
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Introduction 

This guide is designed to help you to choose a debtor statement layout and to makes small changes to it to 
meet your practice requirements. 
 

Need more customisation or assistance?  If you require assistance to edit your Microsoft Word templates, 
or would like the MYOB team to customise your debtor statements for emailing, please contact your Client 
Manager to discuss the consulting service options available to you.   
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Master Debtor Statements Available 

There are 2 types of debtor statements within Practice Manager; debtor statements (also known as open 

item statements) or debtor statements balance forward. 

For each different statement area there is a choice of 8 different statements to choose from: 

• MYOB Classic Debtor Statements Basic remittance with full ageing 

• MYOB Classic Debtor Statement Basic remittance with overdue & current ageing only 

• MYOB Debtor Statements Basic remittance with overdue 

• MYOB Debtor Statements Basic remittance with full ageing 

• MYOB Debtor Statements Credit Card remittance with current ageing only 

• MYOB Debtor Statements Credit Card remittance with full ageing 

• MYOB Debtor Statements Credit Card with Amex remittance with current ageing only 

• MYOB Debtor Statements Credit Card with Amex remittance with full ageing 

 

The master statements come in a choice of either Arial or Times New Roman font, for sites that use 

Practice Manager and those that use Document Manager. 

In the zip files for each different area the beginning of the statement name is different depending on 

whether it’s balance forward or for Document Manager. 

Note: If you use Document Manager please choose a template prefixed MYOB DM. 

Example: 

The statement for “Classic Debtor Statement Basic remittance with overdue & current ageing only” will be 

called either: 

• MYOB Classic Debtor Statement Basic remittance with overdue & current ageing only (Debtor 

statement template) 

Or  

• MYOB Classic Debtor Statement Balance Forward Basic remittance with current & overdue 

ageing only – Arial  (Balance forward template) 

Or 

• MYOB Classic Debtor Statement Balance Forward Basic remittance with current & overdue 

ageing only – Times New Roman   (Times New Roman font) 

Or 

• MYOB DM Classic Debtor Statement Balance Forward Basic remittance with current & overdue 

ageing only – Arial  (for Document Manager sites) 

This example always includes the words of “Classic Debtor Statement + Basic remittance with overdue & 

current ageing only”. 
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MYOB Classic Debtor Statement Basic remittance with full ageing - Arial 

Example Accountants 
 P O Box 1234 Phone: 02 2223356 
 Sydney  NSW  2000 Fax: 02 4344748 
 
 
 

 STATEMENT 
 Client Code:   ADAMSAA 

 Statement Date: 30/11/2016 

 

Date Reference Debit Credit Outstanding Running Balance 

11/11/2013 Invoice 300172 22.00 0.00 22.00 22.00 

3/11/2016 Invoice 300206 550.00 0.00  550.00 572.00 

3/11/2016 Invoice 300207 55.00 0.00 55.00 627.00 

3/11/2016 Invoice 300208 550.00 0.00 550.00 1,177.00 

      

      

      

      

      

      

      

      

      

      

      

Amount Due: $ 1,177.00 

 

181+ Days 121-180 Days 91-120 Days 61-90 Days 31-60 Days 0-30 Days 

22.00 0.00 0.00 0.00 0.00 1,155.00 

 

According to our record, the total outstanding balance stated above was still due at the date given. We would be grateful if you could 

settle this account promptly. Our terms are strictly 14 days. If you have already sent payment to clear this balance, subsequent to the 

statement date, then kindly disregard this statement. 

 

  

----------------------------------------------------------------------------------------------------------------------------- -------------------------------------- 

Remittance Advice 

Please detach and return with payment 

 

Client Name:  Mrs Amy A Adams Amount Due: $ 1,177.00 
 
Client Code:  ADAMSAA Amount Enclosed: $ ____________ 
 
 

Please forward cheques to: Direct payments to:  
  
Example Accounting Limited BSB: 111 222 
PO Box 111 A/C No:  111 222 333 
Sydney NSW 2001  

 

Mrs Amy A Adams 
14 Bligh Street 
SYDNEY  NSW  2000 
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MYOB Classic Debtor Statement Basic remittance with overdue & current ageing only - Arial 

Example Accountants 
 P O Box 1234 Phone: 02 2223356 
 Sydney  NSW  2000 Fax: 02 4344748 
 
 

 

 STATEMENT 

 Client Code:   ADAMSAA 

 Statement Date: 30/11/2016 

 

Date Reference Debit Credit Outstanding Running Balance 

11/11/2013 Invoice 300172 22.00 0.00 22.00 22.00 

3/11/2016 Invoice 300206 550.00 0.00  550.00 572.00 

3/11/2016 Invoice 300207 55.00 0.00 55.00 627.00 

3/11/2016 Invoice 300208 550.00 0.00 550.00 1,177.00 

      

      

      

      

      

      

      

      

      

      

      

 

Overdue Amount Current    Amount Due 

22.00 1,155.00    $ 1,177.00 

 

According to our record, the total outstanding balance stated above was still due at the date given. We would be grateful if you could settle this account 

promptly. Our terms are strictly 14 days. If you have already sent payment to clear this balance, subsequent to the statement date, then kindly disregard 

this statement. 

  

----------------------------------------------------------------------------------------------------------------------------- -------------------------------------- 

Remittance Advice 

Please detach and return with payment 

 

Client Name:  Mrs Amy A Adams Amount Due: $ 1,177.00 
 
Client Code:  ADAMSAA Amount Enclosed: $ ____________ 
 
 

Please forward cheques to: Direct payments to:  
  
Example Accounting Limited BSB: 111 222 
PO Box 111 A/C No:  111 222 333 
Sydney NSW 2001  

 

Mrs Amy A Adams 
14 Bligh Street 
SYDNEY  NSW  2000 
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MYOB Debtor Statement Basic remittance with overdue & current ageing only -  Arial 
 

 

 

 

 STATEMENT 

 Client Code:   ADAMSAA 

 Statement Date: 30/11/2016 

 

Date Reference Debit Credit Outstanding Running Balance 

11/11/2013 Invoice 300172 22.00 0.00 22.00 22.00 

3/11/2016 Invoice 300206 550.00 0.00  550.00 572.00 

3/11/2016 Invoice 300207 55.00 0.00 55.00 627.00 

3/11/2016 Invoice 300208 550.00 0.00 550.00 1,177.00 

      

      

      

      

      

      

      

      

      

      

      

 

Overdue Amount Current    Amount Due 

22.00 1,155.00    $ 1,177.00 

 

According to our record, the total outstanding balance stated above was still due at the date given. We would be grateful if you could settle this account 

promptly. Our terms are strictly 14 days. If you have already sent payment to clear this balance, subsequent to the statement date, then kindly disregard 

this statement. 

-------------------------------------------------------------------------------------------------------------------------------- ----------------------------------- 

Remittance Advice 

Please detach and return with payment 

 

Client Name:  Mrs Amy A Adams Amount Due: $ 1,177.00 
 
Client Code:  ADAMSAA Amount Enclosed: $ ____________ 
 
 

Please forward cheques to: Direct payments to:  
  
Example Accounting Limited BSB: 111 222 
PO Box 111 A/C No:  111 222 333 
Sydney NSW 2001  

 

Mrs Amy A Adams 
14 Bligh Street 
SYDNEY  NSW  2000 
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MYOB Debtor Statement Basic remittance with full ageing - Arial 
 

 

 

 

 STATEMENT 

 Client Code:   ADAMSAA 

 Statement Date: 29/11/2016 

 

Date Reference Debit Credit Outstanding Running Balance 

11/11/2013 Invoice 300172 22.00 0.00 22.00 22.00 

3/11/2016 Invoice 300206 550.00 0.00  550.00 572.00 

3/11/2016 Invoice 300207 55.00 0.00 55.00 627.00 

3/11/2016 Invoice 300208 550.00 0.00 550.00 1,177.00 

      

      

      

      

      

      

      

      

      

      

      

Amount Due: $ 1,177.00 

 

181+ Days 121-180 Days 91-120 Days 61-90 Days 31-60 Days 0-30 Days 

22.00 0.00 0.00 0.00 0.00 1,155.00 

 

According to our record, the total outstanding balance stated above was still due at the date given. We would be grateful if you could 

settle this account promptly. Our terms are strictly 14 days. If you have already sent payment to clear this balance, subsequent to the 

statement date, then kindly disregard this statement.

----------------------------------------------------------------------------------------------------------------------------- -------------------------------------- 

Remittance Advice 

Please detach and return with payment 

 

Client Name:  Mrs Amy A Adams Amount Due: $ 1,177.00 
 
Client Code:  ADAMSAA Amount Enclosed: $ ____________ 
 
 

Please forward cheques to: Direct payments to:  
  
Example Accounting Limited BSB: 111 222 
PO Box 111 A/C No:  111 222 333 
Sydney NSW 2001  

 

Mrs Amy A Adams 
14 Bligh Street 
SYDNEY  NSW  2000 
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MYOB Debtor Statement Credit Card remittance with current & overdue ageing only -  Arial 
 

 

 

 STATEMENT 
 Client Code:   ADAMSAA 

 Statement Date: 30/11/2016 

 

Date Reference Debit Credit Outstanding Running Balance 

11/11/2013 Invoice 300172 22.00 0.00 22.00 22.00 

3/11/2016 Invoice 300206 550.00 0.00  550.00 572.00 

3/11/2016 Invoice 300207 55.00 0.00 55.00 627.00 

3/11/2016 Invoice 300208 550.00 0.00 550.00 1,177.00 

      

      

      

      

      

      

      

      

      

      

      

 

Overdue Amount Current    Amount Due 

22.00 1,155.00    $ 1,177.00 
 

According to our record, the total outstanding balance stated above was still due at the date given. We would be grateful if you could 

settle this account promptly. Our terms are strictly 14 days. If you have already sent payment to clear this balance, subsequent to the 

statement date, then kindly disregard this statement.

----------------------------------------------------------------------------------------------------------------------------- -------------------------------------- 

Remittance Advice 

Please detach and return with payment 

 

Client Name:    Mrs Amy A Adams  Client Code:    ADAMSAA 
 

Please find enclosed a cheque for:    ……………………………………………………….. Amount Due:    $ 1,177.00 
 

Or Debit my:  
 
   
 Card No.:   
 
 Expiry Date:             Amount: $  
 
 Name of Cardholder:   
 
 
 Signature of Cardholder: 
 

 
 

Direct Credit Details : BSB 11 2222   A/C:  99999999 

Mrs Amy A Adams 
14 Bligh Street 
SYDNEY  NSW  2000 
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MYOB Debtor Statements Credit Card remittance with full ageing -  Arial 

 
 

 

 

 STATEMENT 
 Client Code:   ADAMSAA 

 Statement Date: 30/11/2016 

 

Date Reference Debit Credit Outstanding Running Balance 

11/11/2013 Invoice 300172 22.00 0.00 22.00 22.00 

3/11/2016 Invoice 300206 550.00 0.00  550.00 572.00 

3/11/2016 Invoice 300207 55.00 0.00 55.00 627.00 

3/11/2016 Invoice 300208 550.00 0.00 550.00 1,177.00 

      

      

      

      

      

      

      

      

      

      

      

Amount Due: $ 1,177.00 

 

181+ Days 121-180 Days 91-120 Days 61-90 Days 31-60 Days 0-30 Days 

22.00 0.00 0.00 0.00 0.00 1,155.00 
 

According to our record, the total outstanding balance stated above was still due at the date given. We would be grateful if you could settle this account 

promptly. Our terms are strictly 14 days. If you have already sent payment to clear this balance, subsequent to the statement date, then kindly disregard 

this statement. 

 

----------------------------------------------------------------------------------------------------------------------------- -------------------------------------- 

Remittance Advice 

Please detach and return with payment 

 

Client Name:    Mrs Amy A Adams  Client Code:    ADAMSAA 
 

Please find enclosed a cheque for:    ……………………………………………………….. Amount Due:    $ 1,177.00 
 

Or Debit my:  
 
   
 Card No.:   
 
 Expiry Date:             Amount: $  
 
 Name of Cardholder:   
 
 
 Signature of Cardholder: 
 

 
 

Direct Credit Details : BSB 11 2222   A/C:  99999999 

 

Mrs Amy A Adams 
14 Bligh Street 
SYDNEY  NSW  2000 
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MYOB Debtor Statement Credit Card with Amex remittance with current & overdue ageing - Arial 
 

 

 

 STATEMENT 
 Client Code:   ADAMSAA 

 Statement Date: 30/11/2016 

 

Date Reference Debit Credit Outstanding Running Balance 

11/11/2013 Invoice 300172 22.00 0.00 22.00 22.00 

3/11/2016 Invoice 300206 550.00 0.00  550.00 572.00 

3/11/2016 Invoice 300207 55.00 0.00 55.00 627.00 

3/11/2016 Invoice 300208 550.00 0.00 550.00 1,177.00 

      

      

      

      

      

      

      

      

      

      

      

 

Overdue Amount Current    Amount Due 

22.00 1,155.00    $ 1,177.00 
 

According to our record, the total outstanding balance stated above was still due at the date given. We would be grateful if you could 

settle this account promptly. Our terms are strictly 14 days. If you have already sent payment to clear this balance, subsequent to the 

statement date, then kindly disregard this statement.

----------------------------------------------------------------------------------------------------------------------------- -------------------------------------- 

Remittance Advice 

Please detach and return with payment 

 

Client Name:    Mrs Amy A Adams  Client Code:    ADAMSAA 
 

Please find enclosed a cheque for:    ……………………………………………………….. Amount Due:    $ 1,177.00 
 

Or Debit my:  
 
   
 Card No.:   
 
 Expiry Date:             Amount: $  
 
 Name of Cardholder:   
 
 
 Signature of Cardholder: 
 

 
 

Direct Credit Details : BSB 11 2222   A/C:  99999999 

Mrs Amy A Adams 
14 Bligh Street 
SYDNEY  NSW  2000 
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MYOB Debtor Statement Credit Card with Amex remittance with full ageing - Arial 
 

 

 STATEMENT 
 Client Code:   ADAMSAA 

 Statement Date: 30/11/2016 

 

Date Reference Debit Credit Outstanding Running Balance 

11/11/2013 Invoice 300172 22.00 0.00 22.00 22.00 

3/11/2016 Invoice 300206 550.00 0.00  550.00 572.00 

3/11/2016 Invoice 300207 55.00 0.00 55.00 627.00 

3/11/2016 Invoice 300208 550.00 0.00 550.00 1,177.00 

      

      

      

      

      

      

      

      

      

      

      

Amount Due: $1,177.00 

 

181+ Days 121-180 Days 91-120 Days 61-90 Days 31-60 Days 0-30 Days 

22.00 0.00 0.00 0.00 0.00 1,155.00 

 

According to our record, the total outstanding balance stated above was still due at the date given. We would be grateful if you could 

settle this account promptly. Our terms are strictly 14 days. If you have already sent payment to clear this balance, subsequent to the 

statement date, then kindly disregard this statement.

----------------------------------------------------------------------------------------------------------------------------- -------------------------------------- 

Remittance Advice 

Please detach and return with payment 

 

Client Name:    Mrs Amy A Adams  Client Code:     ADAMSAA 
 

Please find enclosed a cheque for:    ……………………………………………………….. Amount Due:    $ 1,177.00 
 

Or Debit my:  
 
   
 Card No.:   
 
 Expiry Date:             Amount: $  
 
 Name of Cardholder:   
 
 
 Signature of Cardholder: 
 

 
Direct Credit Details : BSB 11 2222   A/C:  99999999 

Mrs Amy A Adams 
14 Bligh Street 
SYDNEY  NSW  2000 
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How to modify your statement templates 

If you use MYOB Document Manager please refer to the online F1 help links below.  If you do not use 

Document Manager please use the links for Practice Manager below. 

 

Practice Manager: 

Region  Product Link 

Australia AE/AO Emailing Debtor Statements from Practice 
Manager 

New Zealand AE/AO Emailing Debtor Statements from Practice 
Manager 

 

Document Manager: 

Region  Product Link 

Australia AE/AO Emailing Debtor Statements from Document 
Manager 

New Zealand AE/AO Emailing Debtor Statements from Document 
Manager 

  
 

 

 

 

  

https://help.myob.com/wiki/x/gDCEAQ
https://help.myob.com/wiki/x/gDCEAQ
https://help.myob.com/wiki/x/gDCEAQ
https://help.myob.com/wiki/x/gDCEAQ
https://help.myob.com/wiki/x/CyWEAQ
https://help.myob.com/wiki/x/CyWEAQ
https://help.myob.com/wiki/x/CyWEAQ
https://help.myob.com/wiki/x/CyWEAQ
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Hints and tips for editing statement templates 

You have a choice of using a template that has a blank letterhead so you can bring in your practice 

logo or one with a pre-typed letterhead and no logo. 

 

Pre typed letterhead statement 

Where you can type over with your practice details: 

 

 

How to bring your practice logo into a blank letterhead template 

Click in the document where you want to insert the logo. 

 

 

1. Click the Insert tab on the command ribbon. 

2. Select Pictures 

3. Find the image and double-click the image file that contains your logo.  

The image appears on the document. 

4. Click the image to show the Picture Tools ribbon. 

5. Click the Format tab. 

6. Click the down arrow next to the Wrap Text button.  

7. Select More Layout Options.  

The Layout dialog window opens. 

8. Right click on the logo and select Format Picture. 

9. Select  the Layout tab and click Tight. 

You can now re-size your logo and move it around. 

  



P a g e  16 
 

To re-size the logo 

To re-size the logo, click the outline. Click and drag the frame’s sizing handles to the preferred size 

and to the right location on your statement. 

 

 

 

 

 

 

 

 

 

 

 

 

  

Text box for the name 

and address which can 

be moved around and 

expanded 

  

This table has 15 rows.  You cannot have more but you can delete some lines if 

necessary.  If the statement has more transactions than the number of rows in the 

table, that statement will go over to a second page.  If you cannot see the outline 

of the table you need to put the cursor on the table, select Layout from the table 

tools and then select View Gridlines.  

This text is tabbed so 

you can move the tabs 

to format to your liking 
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Colour shading the line 

 

To change the shading of the line, click on the shape, right click and select Format AutoShape. 

On the Colors and Lines tab select the colour you want to use in both the Fill and Line sections and 

click OK. 

  

 

Debtors ageing 

Depending on the template chosen it can show current & overdue or full ageing.  It is best to select 

the template with the correct ageing option.  If your practice does decide to change the ageing you 

can copy the table from the master that includes that ageing option to your template. 

 

 

 

Reminder information  

This is typed text which is left aligned and can be changed or centred to suit your practice. 
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Remittances 

 

The remittance depends on the template chosen.  

Basic remittance 

 

 

Credit card remittance 

Displays Visa and Mastercard only – no Amex 
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Credit Card with Amex remittance 

 

 

 

Note 

The letterhead and remittance will appear on all pages of the statement for each client.  For example, 

if the table in the template has 15 rows and the client has more than 15 outstanding transactions, the 

statement will go to 2 pages and each page will show the letterhead and remittance.  

 


